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As with the macros in the “Automated Drawing” chapter, there 
are several 3D macros that can also be accessed through the 
Macros pull-down menu. With these macros, you can draw 3D 
stairs, windows, and doors, insert concrete forms, and do 3D 
framing and roofs. 

When you choose Toolbox from the Edit menu, a dialog box 
appears with all 2D and 3D macros. Select a macro (.DCX) file 
from the list and click Open, or double-click on the macro 
filename to use the tool. Click on Cancel to cancel the operation. 

In this chapter: 

± Adding 3D doors and 
windows to your 
model  

± Constructing 3D stairs 

± Inserting 
preconstructed 
concrete forms into 
your drawing or model 

± Creating 3D framing 
models 

± Creating Gable, Hip, 
Boston, Gambrel, 
Mansard, or Shed 
roofs 
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Tutorial 
This section of the Tutorial guides you through some of the more commonly used 
items of the Toolbox to help you complete the schoolhouse. In order to keep this 
exercise simple, and to help you understand a little about 3D spatial relationships, 
you will work in orthographic (plan) view and then use the 3DViews menu to view 
your work.  

Setting Up for 3D Modeling 
You will create five new layers for the 3D items that you are going to add to the 
drawing. This enables your drawing file to contain both your plan drawings, used 
for construction documentation, and 3D drawings, used to present your designs. 

1. If you are not in DataCAD, start DataCAD now and choose the drawing file that 
you worked on in the previous chapters. 

2. Add five new layers to your drawing file. 

3. Name the new layers: 3DWalls, 3DDoors, 3DWindow, 3DRoof, and 3DMisc. 

4. Go to the Layers menu. 

5. Turn off Doors, Windows, Plumb, Dim, Hatch, Notes, Misc, and Border. 

6. Press (Esc) on the keyboard to refresh the drawing display. 

7. Window in on the lower half of the plan. 

Adding Windows 
You will work with the walls, doors, and windows that you have already placed in 
your drawing. Do not erase them; they are an essential part of your drawing file. 

1. Make the 3DWindow layer the active layer. 

2. Choose Toolbox from the Edit menu. 

3. Choose AEC_MODL. You are prompted: Select building component to model. 

4. Choose Windows to go to the WindElev menu. 

5. Choose In Plan to draw the windows in plan view. 

6. Choose UnitType. You are prompted: Select type of window unit. 

7. Choose DblHung to draw double-hung windows. 

8. Return to the WindPlan menu. 

9. Choose Glass to go to the Glass menu. 
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10. Choose PaneHorz to define the number of glass panes (divisions) across the 
window. You are prompted: Number of panes in the horizontal direction. 

11. Choose 3. 

12. Choose PaneVert to define the number of glass panes top to bottom in the 
window. You are prompted: Number of panes in the vertical direction. 

13. Choose 2. 

14. Return to the WindPlan menu. You are prompted: Enter a point on first inside 
corner of window. 

15. Click the middle mouse button on an inside corner of the front window opening 
in the office. You are prompted: Enter a point on second inside corner of window.  

16. Click the middle mouse button the other inside corner of the window opening. 
You are prompted: Enter a point on outside surface of wall.  

17. Click the middle mouse button on the outside of the wall. The window is 
created. 

15
Click the middle mouse
button to define the first
inside corner of the
window.

16
Click the middle mouse
button to define the other
inside corner of the window.

17
Click the middle mouse
button to define the
outside corner of the
window.   

Placing windows 

18. Repeat steps 15 - 17 to create the remaining windows. Remember that you can 
use the arrow keys on the keyboard to move around the drawing. 
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The 3D windows are drawn 

19. When you are finished placing windows, return to the AEC_MODL menu. 

Adding 3D Doors 
1. Make 3DDoors the active layer. 

2. Choose Doors from the AEC_MODL menu to go to the DoorPlan menu. You are 
prompted: Enter a point on first inside corner of door. 

3. Move the cursor to an inside corner of the door opening in the office and click 
the middle mouse button. You are prompted: Enter a point on second inside corner 
of door.  

4. Move the cursor to the other inside corner of the door and click the middle 
mouse button. You are prompted: Enter a point on outside surface of wall.  

5. Move the cursor to the outside corner of the wall and click the middle mouse 
button. The first door is created. 

6. Choose Door. You are prompted: Select door data to change. 

7. Choose HingLft to change the hinge side of the front door to the left side. 

8. Return to the DoorPlan menu. 

9. Repeat steps 3 - 5 for the remaining doors. 
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3
Click the middle mouse
button to define the first
inside corner of the door.

4
Click the middle mouse
button to define the other
inside corner of the door.

5
Click the middle mouse
button to define the
outside surface of the
wall.

 

Placing the first door 

10. Return to the Edit menu. 

11. Recalculate the extents of the drawing. 

  

The doors are drawn 

There are many other options you can use when placing doors and windows.  
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Viewing the 3D Model 
Choose Isometric from the View menu on the Menu Bar. You will learn more 
viewing techniques in the Tutorial section of the “3D Viewing” chapter. 

  

An isometric view of the schoolhouse walls, windows, and doors 

Adding a 3D Roof 
As mentioned throughout this book, layers allow you more control over your 
drawing. Later in this section of the Tutorial you will use these different layers to 
switch between viewing construction plans and presentation graphics. 

1. Change to the 3DRoof layer. 

2. Change the color of the 3DRoof layer to Magenta. 

3. Choose Toolbox from the Edit menu. 

4. Choose ROOFIT from the dialog box to go to the RoofIt menu. 

5. Choose Gable to create a gable roof. 

6. Choose Settings. 

7. Set the wall thickness to 1 foot. 

8. Return to the RoofIt menu. You are prompted: Pick the 1st point of roof boundary.  

9. Select the lower-left corner of the exterior wall with the middle mouse button. 
You are prompted: Enter second point of roof length.  

10. Select the upper-left corner of the exterior wall with the middle mouse button. 
You are prompted: Enter second point of roof width.  
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11. Select the upper-right corner of the exterior wall with the middle mouse button. 
The roof appears on top of the walls. 

12. Return to the Edit menu. 

It is important to select the points of the roof boundary in a clockwise direction to ensure that 
the roof will be placed correctly. 

13. Choose Isometric from the View menu on the Menu Bar to view the drawing in 
isometric. 

  

An isometric view of the schoolhouse shows the new roof 

Finishing the Schoolhouse Drawing 
Notice that in the isometric view, portions of the wall above and below the 
windows are missing. You will fix them in the next exercise, but these wall 
segments are going to be put on a different layer than the existing Walls layer. Later 
in this chapter you will see the reason for having two wall layers. 

1. Choose Orthographic from the View menu on the Menu Bar to view the 
schoolhouse in plan view. 

2. Choose Layers from the Utility menu in the Menu Window. 

3. Make 3DWalls the active layer, with only walls turned on. All other layers 
should be off. 

4. Change the 3DWalls layer color to yellow. 
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5. Toggle the Walls option on. 

6. Toggle the 2-line wall option on. 

7. Set a new wall width of 1 foot. 

8. Toggle Outside on. 

9. Toggle Cap off, if it is on. 

10. Press (Z) on the keyboard. You are prompted: Enter new Z-base. 

11. Type 0 and press (Enter). You are prompted: Enter new Z-height. 

12. Type 3.4 and press (Enter). You have just established a new 3D setting for all new 
items you draw. All lines will now be drawn with a Z-base of 0 and a Z-height of 
3’-4”. 

13. Window in on the lower half of the plan. 

14. Return to the Edit menu. You are prompted: Select first end point of new line/wall. 

15. Move the cursor to an outside corner of the window opening in the office and 
click the middle mouse button. You are prompted: Select next end point of 
line/wall. 

16. Move the cursor to the other outside corner of the window and click the middle 
mouse button. You are prompted: Select a point to define the Inside of the wall. 

17. Move the cursor anywhere on the inside of the plan and click. The cutout is 
filled. 

18. Right-click to disconnect from the wall you just drew. 

19. Repeat steps 15 - 18 for the remaining exterior window openings. Be sure to 
disconnect from each wall segment you draw, before drawing the next. 
Remember to use the arrow keys on the keyboard to move around the drawing. 

20. Press (Z) on the keyboard. You are prompted: Enter new Z-base. 

21. Type 6.8 and press (Enter). You are prompted: Enter new Z-height. 

22. Type 8 and press (Enter). You have just established a new 3D setting for all new 
items you draw. All lines will now be drawn with a Z-base of 6.8 and a Z-height 
of 8’-0”. 
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15
Click the middle mouse
button to define the first
end point of the new wall.

16
Click the middle mouse
button to define the next end
point of the new wall.

17
Click the first mouse
button to define the inside
of the wall.

 

Placing headers and sills 

23. Repeat steps 15 - 18 to fill in over top of the sills to create window headers. You 
are prompted: Select first end point of new line/wall. 

24. Click the middle mouse button at the outside corner of the front door opening. 
You are prompted: Select next end point of line/wall. 

25. Move the cursor to the other outside corner of the door and click the middle 
mouse button. You are prompted: Select a point to define the Inside of the wall. 

26. Move the cursor anywhere on the interior of the plan and click. The door header 
is drawn. 

27. Press (=) on the keyboard. The Message Window reads Walls will NOT be drawn. 

28. Press (=) again. You are prompted: Enter new wall width. 

29. Type .4 and press (Enter). You are now set to draw the headers above the interior 
doors. 

30. Move the cursor to an outside corner of the interior door opening in the office. 

31. Repeat steps 24 - 26 to complete this header and the remaining interior headers. 

32. Choose Isometric from the View menu on the Menu Bar to view the isometric 
view. 

33. Toggle the 3DDoors, 3DWindow, and 3DRoof layers on. 

34. Return to the Utility menu. 

35. Recalculate the extents of the drawing. 



Tutorial 

 482  / 3D Modeling

 

This completes the Automated Modeling Tutorial. To continue with the tutorial 
exercises, turn to the “Tutorial” section at the beginning of the “3D Viewing” 
chapter. 
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3D Stairs 
The 3DStairs menu provides everything you need to create a set of three-
dimensional stairs. 3DStairs creates real stairs, not stacked slabs, making this 
representation of stairs more accurate than ever before. The 3DStairs macro has 
these main features: 

• seven predefined stair types -- single-run, straight-run, double-back, L-shaped, 
open-well, curved, and spiral 

• a stair calculator, which makes it easy for you to calculate the values of stair 
settings and then readjust the Settings menu values 

With the stair forms and other settings you can customize the shape and placement 
of stair components. There are three ways to define the settings for the type of stairs 
you want to model: 

• use the 3DStairs/Settings menu to select options and enter individual values for 
the various stair components 

• use the Stair Form to display the settings on the screen for reference and/or 
customization 

• save your stair settings to a file through the StrFile menu; when you want to 
model that specific stair type again, you can recall the file 

Because of the interactive nature of stair components, changing one option can cause other 
options to change automatically. For example, when you close stringers, you can’t have tread 
extensions. 

The sections that follow describe how to create each stair type. You can only use the 
Stair Calculator for single-run stairs; see “The Stair Calculator” later in this section 
for more information. 

è To draw 3D stairs: 

1. Choose Toolbox from the Edit menu. 

2. Choose 3DStairs from the Toolbox dialog box.  

3. Choose a stair type. 
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StraightSingle

L-ShapedSpiralDouble Back

CurvedOpenWell
 

Stair types 

4. Set the options for the stair style you want. You can use either the Settings menu, 
the Stair Form, or you can load a stair file. When you model single-run stairs, 
you can use the Stair Calculator to determine the settings. See “Stair Settings” 
later in this section for more information. 

5. Choose Begin to place the stairs. The tool automatically changes to a plan view 
and a boundary box appears representing the run of stairs. 

When Ortho mode is on, the boundary box does not track with the cursor. Press (O) to toggle 
Ortho mode off. 

6. Drag the stairs by the lower outside corner of the first run to the new stair 
position. The boundary box rotates as you move your cursor. 

7. Rotate the stairs to the angle you want. The box rotates as you move the cursor. 

8. Click to place the stairs. The stair model appears in the selected location with the 
settings you chose. 
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9. To change the results, erase the last group by pressing (Shift) + (<) and repeat 
steps 3 through 7. 

Stair Settings 
Use the Settings menu to change the settings for 3DStairs. Different options appear 
depending on the stair type you selected from the 3DStairs menu.  

The options in the top half of the menu are global settings that apply to all stair 
types. The bottom half of the menu are stair component submenus. Each of these 
submenus contains the various settings for that particular component. 

When you choose any of the Settings options, a list of values appears. Choose a 
value or press (Enter) to accept the given value. 

Base Elevation 
Use BaseElev to change the base elevation of a flight of stairs. Base elevation is the 
height, or elevation, at which the flight of stairs begins. 

 

Total
Rise

Tread Depth

Riser
Height

Base Elevation

Top Landing

 

Base Elevation 

Treads 
Use TrdLngth to change the tread length. The tread length is the horizontal distance 
from one side of the tread to the other side. It does not include tread extension 
values. Any tread extensions are added to the tread length and only apply to stairs 
modeled with open stringers.  
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Tread
Length

Open Stringer

Tread
Length

Closed Stringer

 

Tread length 

Use Trd/Run1 to change the number of treads in the first run of stairs. This applies 
to all stair types. The number of treads does not include the landing at the top of the 
run and is equal to one less than the number of risers. 

Use Trd/Run2 to change the number of treads in the second run of stairs. Trd/Run2 
is only available for straight, double-back, open-well, and L-shaped stairs.  

Use Trd/Run3 to change the number of treads in the third run of stairs. Trd/Run3 is 
only available for open-well stairs.  

Radius of Curved Stairs 
Use Radius to change the inner radius of curved and spiral stairs. Measure Radius 
from the exact center point to the inside face of the stringer for curved stairs and the 
radius of the center pole for spiral stairs.  

 

Radius

Tread
Depth

 

Radius on a curved flight of stairs 

Clockwise 
Clkwise applies to all stair types except single and straight. You can place the stairs 
clockwise or counterclockwise depending on your needs. 
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Chases 
Use Chase to control the horizontal distance between the runs of a double-back 
flight of stairs. This setting effects the width of the intermediate landing and the 
tread length. 

 

Intermediate Landing

Double Back Stairs,
Plan View

Chase  

Chase 

Landings 
The top, bottom, and in some cases, intermediate landings all have depth and 
thickness settings. You can change the specific settings for each landing you create 
using the Landing menu in the 3DStairs/Settings menu. (Changing the settings on 
the top landing does not affect the settings of the bottom landing, and vice versa.) 

Toggle DoLndTp on to model a landing at the top of the flight of stairs; toggle 
DoLndBt on to model a landing at the bottom of a flight of stairs. 

The Depth option sets the landing depth. The landing depth is the horizontal distance 
from the front of the landing to the rear of the landing. When you model L-shaped 
or open-well stairs, you cannot set a landing depth on the intermediate landing. The 
landing depth equals the width of the run of stairs. 
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Landing depth 

Thicknss shows the current thickness of a landing. Measure the landing thickness 
vertically from the underside to the top side. Thicknss sets the top, intermediate, 
and bottom landing thicknesses. 

For stair types that have intermediate landings, IntrLand is always on. It is available 
for straight, double-back, open-well, or L-shaped stairs only. For rectangular or 
curved intermediate landings, use the Rectangl/Curved option; this is available for 
L-shaped, double-back, or open-well stairs only.  

 

Open Well

Double Back

L-Shaped  

Rectangular / curved intermediate landings 
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Use Color to set the landing color. All landings in a single flight of stairs are 
modeled using the same color. See “Color Menus” in “The Drawing Board” chapter 
for more information about how to choose a color. 

Risers 
Use the Riser menu to set options that create risers and determine riser height, 
thickness, and color. Toggle DoRiser on to model risers on your flight of stairs. 

RiserHgt displays the current riser height in the Message Window and lets you reset 
it. The riser height is the vertical distance from the top of one tread to the top of the 
next.  

 

Total
Rise

Tread Depth

Riser
Height

Base Elevation

Top Landing

 

Riser height, total rise, and tread depth 

The Thicknss option displays the current riser thickness in the Message Window 
and lets you reset it. The riser thickness is the horizontal distance from the front side 
of the riser to the backside of the riser when you choose Thicknss. 

Use Color to set the landing color. All landings in a single flight of stairs are 
modeled using the same color. See “Color Menus” in “The Drawing Board” chapter 
for more information about how to choose a color. 

Treads 
Use Tread to set options that model treads and determine the depth, thickness, and 
nosing of the treads. Toggle DoTread on to automatically calculate and model treads 
on a flight of stairs. 

Depth displays the current tread depth in the Message Window and lets you reset it. 
The tread depth is the horizontal distance from the front of one tread to the front of 
the next tread. When you select a spiral stair, TredDegs (tread degrees) is displayed 
in the menu in place of depth. Tread degrees displays the inclusive angle of the 
treads on spiral stairs in the Message Window and lets you reset it. 
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Total
Rise

Tread Depth

Riser
Height

Base Elevation

Top Landing

 

Tread depth 

Thicknss displays the current tread thickness in the Message Window and lets you 
reset it. The tread thickness is the vertical distance from the top side of the tread to 
the bottom side of the tread. 

LeftExtn and RghtExtn display the current left and right extension, respectively, of 
the tread in the Message Window and lets you reset it. Left extension includes tread 
length, the distance from one stringer to the next. LeftExtn controls the distance that 
the tread extends beyond the outside of the stringer. LeftExtn is available only for 
stairs with open stringers. 

 

Left Tread
Extension

 

Tread extension 

When Nosing is toggled on, you can set the nosing length and type for treads. 
3DStairs prompts you for an overhang value when you toggle nosing on. Nosing 
controls the distance that the front of the tread extends beyond the front of the riser. 
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To set the nosing type to square or round, click on the RndNosng/SqrNosng toggle. 
This Nosing option changes between round and square just by clicking on it. If 
RndNosng is displayed in the Nosing menu, round nosing will be drawn on the 
stair treads; if SqrNosng is displayed in the Nosing menu, square nosing will be 
drawn on the stair treads. 

 

Square
Nosing

Round
Nosing

 

Nosing 

Use Color to set the color for the treads. All treads in a flight of stairs are the same 
color. See “Color Menus” in “The Drawing Board” chapter for more information 
about how to choose a color. 

Stringers 
Stringer allows you to set options that create stringers and determine where and 
what kind you want to use. Toggle DoLeft on to model a stringer on the left side of 
the run of stairs,  toggle DoCtr on to model a stringer in the center of a run of stairs, 
or toggle DoRght on to model a stringer on the right side of the stairs. 

When using DoCtr, the stringer is always modeled as an open stringer. 

Use the ClosdStr/OpenStr toggle to set the stringer type to open or closed. When 
ClosdStr is displayed in the Stringer menu, stringers will be modeled as closed; 
when OpenStr is displayed in the Stringer menu, stringers will be modeled as open. 
Choose ClosdStr or OpenStr to toggle between the two options. 

Width displays the current width of the stringer in the Message Window and lets 
you reset it. Measure the width from the top edge of the stringer to the bottom edge 
of the stringer. 
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Stringer Width,
Closed Stringer

Stringer Width,
Open Stringer

 

Stringer width (open or closed) 

The stringer thickness is the horizontal distance from the inside of the stringer to the 
outside of the same stringer. Choose Thicknss from the Stringer menu, and then 
choose or type a new thickness value and press (Enter). 

 

Stringer
Thickness

 

Stringer thickness 

Use Color to set the color for the stringer. All stringers in a flight of stairs are 
modeled using the same color. See “Color Menus” in “The Drawing Board” chapter 
for more information about how to choose a color. 
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Handrails 
Toggle DoLeft on to model a handrail on the left side of the flight of stairs. Toggle 
DoRght on to model a handrail on the right side of a flight of stairs. When either of 
these options are toggled off, 3DStairs does not model the handrails on that side of 
the stairs. 

The Rectangl/Cylinder toggle lets you choose between modeling a cylindrical or 
rectangular handrail. When you select Cylinder, the Radius and Division options 
appear for you to enter settings. When you select Rectangl, the Width and Depth 
options appear for you to set. 

The Radius/Width toggle displays the current radius or width of the handrail in the 
Message Window, depending on whether you selected cylindrical or rectangular 
handrails. When you model a cylindrical handrail, you can adjust the radius of the 
cylinder. When you model a rectangular handrail, you can adjust the width of the 
rectangle. Measure width from the top of the handrail to the bottom of the handrail. 

  

Handrail width and depth 

The Depth/Division toggle displays the current depth or number of divisions in the 
handrail in the Message Window, depending on whether you select cylindrical or 
rectangular handrails. When you model a cylindrical handrail, you can adjust the 
division of the cylinder, or the number of sides in the cylinder. When you model a 
rectangular handrail, you can adjust the depth of the rectangle. Measure depth from 
one side of the handrail to the other side. You can use up to 36 divisions, but the 
more divisions you have, the longer it takes DataCAD to redraw. 

Use Height to see or reset the current height of the handrail. Measure handrail 
height from the top surface of the handrail to the top of the tread. 
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Handrail
Height

 

Handrail height 

Use Color to set the color for the handrails. All handrails in a flight of stairs are 
modeled using the same color. See “Color Menus” in “The Drawing Board” chapter 
for more information about how to choose a color. 

Balusters 
Use the Baluster menu in the 3DStairs/Settings menu to choose what kind of 
balusters, if any, to use for your stairs. Toggle DoBalus in the Baluster menu on to 
model balusters on your flight of stairs. 

The Baluster menu has three options for baluster placement. OnSide models 
balusters on the sides of the stringers, OnTread models balusters on the treads, and 
OnStrng models balusters on the center of the stringer. OnStrng is available only 
when you model a closed stringer. 

Depending on whether you choose OnSide, OnTread, or OnStrngr for baluster 
placement, either the Bal/Tred or Bal/Run1 option is displayed in the Baluster 
menu. The Bal/Tred option displays the number of balusters per tread in the 
Message Window and lets you change the value. Bal/Tred is only available when 
you use OnTread. The Bal/Run1 option displays the current number of balusters in 
the first run of the stairs in the Message Window and lets you change that value. 
Bal/Run1 is available only when you place the balusters on the side of the stringer 
(OnSide) or on the stringer (OnStrng). 

The Bal/Run2 option displays the current number of balusters in the second run of 
the stairs in the Message Window and lets you change that value. Bal/Run2 is 
available only when you place the balusters on the side of the stringer (OnSide) or 
on the stringer (OnStrng) on straight, double-back, open-well, and L-shaped stairs. 

The Bal/Run3 option displays the current number of balusters in the third run of 
the stairs in the Message Window and lets you change that value. Bal/Run3 is 
available only when you place the balusters on the side of the stringer (OnSide) or 
on the stringer (OnStrng) on open-well stairs. 
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Use Cylinder/Rectangl to choose between modeling a cylindrical or rectangular 
baluster. When you select Cylinder, the Radius and Division options appear. When 
you select Rectangl, the Width and Depth options appear. 

The Radius/Width toggle displays the current radius or width of the baluster in the 
Message Window, depending on whether you selected cylindrical or rectangular 
balusters. When you model a cylindrical baluster, you can adjust the radius of the 
cylinder. When you model a rectangular baluster, you can adjust the width of the 
rectangle. Measure width from one side to the other of one baluster. 

The Depth/Division toggle displays the current depth or number of divisions in the 
baluster in the Message Window, depending on whether you selected cylindrical or 
rectangular balusters. When you model a cylindrical baluster, you can adjust the 
division of the cylinder, or the number of sides in the cylinder. When you model a 
rectangular baluster, you can adjust the depth of the rectangle. Measure depth from 
the front to the back of the baluster. 

You can use up to 36 divisions, but the more divisions you have, the longer it takes DataCAD 
to redraw. 

 
Width

Depth  

Baluster width and depth 

Use Symbol to model balusters as symbols. When balusters are symbols, you can 
replace the balusters produced by 3DStairs with different, more detailed baluster 
symbols that you create. 

è To use custom balusters in stairs: 

1. Create your detailed baluster in the DataCAD drawing window and save it as a 
symbol. See “Saving and Deleting Symbols” in the “Templates and Symbols” 
section of the “Drawing Elements” chapter. 

2. Choose 3DStairs from the Toolbox dialog box. 

3. Set the baluster options as necessary. 

4. Toggle Symbol on to draw the balusters as symbols. 
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5. Create your run of stairs. 

6. Replace the existing balusters with the symbol you created in step 1 using the 
Replace option in the Template menu. See “Replacing a Symbol” in the 
“Templates and Symbols” section of the “Drawing Elements” chapter. 

 

 Balusters on Stringer Balusters on Side Balusters on Tread  

Baluster placement 

VertOfst shows the current vertical offset of the baluster. Vertical is the distance that 
the bottom end of the balusters extends below the treads. Vertical offset appears 
only when you select OnSide.  

 

Baluster
offset

 

Baluster vertical offset 

HorzOfst shows the current horizontal offset of the baluster. When you model 
balusters on the treads, measure the offset from the side edge of the tread to the 
middle of the baluster. HorzOfst only appears when you select OnTread. 



3D Stairs 

 Automated Modeling /  497

 

Baluster offset,
Closed stringer

Baluster offset,
Open stringer

 

Baluster horizontal offset 

Use Color to set the color for the balusters. All balusters in a flight of stairs are 
modeled using the same color. See “Color Menus” in “The Drawing Board” chapter 
for more information about how to choose a color. 

Newel Posts 
Use NewelPst to model newel posts on the stairs. Toggle DoNlPst on to model 
newel posts on a flight of stairs. When DoNlPst is toggled off, 3DStairs models 
balusters in place of newel posts.  

 On Off  

Newel posts on/off 

Use Cylinder/Rectangl to choose between modeling a cylindrical or rectangular 
newel post. When you select Cylinder, the Radius and Division options are 
displayed. When you select Rectangl, the Width and Depth options are displayed. 

The Radius/Width toggle displays the current radius or width of the newel post, 
depending on whether you selected cylindrical or rectangular newel posts, in the 
Message Window. When you model a cylindrical newel post, you can adjust the 
radius of the cylinder. When you model a rectangular newel post, you can adjust 
the width of the rectangle. Measure width from one edge, near a baluster, to the 
other edge, facing out, of the same newel post 
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The Depth/Division toggle displays the current depth or number of divisions in the 
newel post, depending on which of the previous options you selected, in the 
Message Window. When you model a cylindrical newel post, you can adjust the 
division of the cylinder, or the number of sides in the cylinder. When you model a 
rectangular newel post, you can adjust the depth of the rectangle. Measure depth 
from the edge of the newel post near the handrail to the open edge. 

You can use up to 36 divisions, but the more divisions you have, the longer it takes DataCAD 
to redraw. 

 Depth Width 

Newel post width and depth 

Use Symbol to model newel posts as symbols. When newel posts are symbols, you 
can replace the newel posts produced by 3DStairs with custom newel post symbols 
that you create. 

è To use custom newel posts in stairs: 

1. Create your detailed newel post in the DataCAD drawing window and save it 
as a symbol. See “Saving and Deleting Symbols” in the “Templates and 
Symbols” section of the “Drawing Elements” chapter. 

2. Choose 3DStairs from the Toolbox dialog box. 

3. Set the newel post options as necessary. 

4. Toggle Symbol on to draw the newel posts as symbols. 

5. Create your run of stairs. 

6. Replace the existing newel posts with the symbol you created in step 1 using the 
Replace option in the Template menu. See “Replacing a Symbol” in the 
“Templates and Symbols” section of the “Drawing Elements” chapter. 
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Use Color to set the color for the newel posts. All newel posts in a flight of stairs are 
modeled using the same color. See “Color Menus” in “The Drawing Board” chapter 
for more information about how to choose a color. 

Stair Form 

è To display values and settings for all stair types: 

1. Choose StrForm from the 3DStairs menu. 

2. Press (Tab¿) to move forward or (Shift) + (Tab¿) to move backward through each 
line of the stair form.  

3. Scroll through the two-page form by selecting ScrlFwrd or ScrlBack from the 
menu.  

4. Press (Esc) to save settings and exit the StrForm menu, or choose Exit to leave the 
StrForm menu without saving any changes. For settings with options, you can 
scroll through them using (Spacebar). 

Stair File 
Use the StrFile option in the 3DStairs menu to save stair settings for future use, as 
well as load, save, delete, and rename stair setting files: 

LoadStr Loads a stair settings file; choose LoadStr from the StrFile menu and 
type the name of the file to load 

SaveStr Saves your current stair settings to a file; choose SaveStr from the 
StrFile menu and type the name of the file to save 

DelStr Deletes a stair settings file; choose DelStr from the StrFile menu and 
type the name of the file to delete 

Rename Renames an existing stair file; choose Rename from the StrFile menu, 
choose the file to rename, and type a new name 

StrForm Shortcut to the Stair Form menu; see “Stair Form” above for more 
information 
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The Stair Calculator 
The Stair Calculator (Calculat) is available only when you create single-run stairs. 
Use it to calculate one of six possible values: total rise, number of risers, riser height, 
total run, number of treads, or tread depth. 

Use the Stair Calculator as you would use a desktop calculator; prompts are 
displayed in the Message Window at the bottom of the screen. Save the answers to 
automatically update the 3DStairs/Settings menu for single-run stairs. 

1. Choose Calculat from the 3DStairs menu.  

2. Select an option from the Calculat menu to calculate and modify: 

TotlRise The number of risers times the riser height; same value regardless of 
whether LandTop is on or off 

# Risers The total rise divided by the riser height, including the rise of the top 
landing; changing the number of risers automatically changes the 
number of treads and vice versa 

RiserHgt The vertical distance from the top of one tread to the top of the next 
tread; the total rise divided by the number of risers 

TotalRun The horizontal distance from the top of the run of stairs to the bottom 
of the stairs; the number of treads times the tread depth (the distance 
can include landing depth for the top and bottom landings when those 
toggles are turned on) 

# Treads The number of treads in the stair run; changing the number of treads 
automatically changes the number of risers and vice versa (you can set 
TreadDth from this menu to recalculate the number of treads) 

TreadDth The horizontal distance from the face of one riser to the face of the next 
riser; the total run divided by the number of treads (you can change # 
Treads in this menu) 

LandBtm When LandBtm is on, the total run value includes the bottom landing 
depth 

LandTop When LandTop is on, the total run value includes the top landing 
depth 

Reset Resets your calculator settings to the default values 

Update Overwrite the old settings in the Setting menu with new settings; 
saves your calculated values 

Begin Use Begin to start modeling stairs. Follow the steps in the “Using 
Stairs” section for information on using Begin. 

Template Shortcut to the Template menu; select a template from the menu, or 
type a template name, and press (Enter) 
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Hide Perform hidden line removals; see “Hide” in the “3D Editing” chapter 
for more information 

3DViews Shortcut to the 3DViews menu; see the “3D Viewing” chapter for more 
information 

3. With some Calculat menu options, an additional submenu is displayed. If the 
occurs, choose an option to modify; if not, skip to step 5. 

4. Choose a new value from the menu or type a different value. As you change the 
values of a setting, the results are automatically calculated and displayed.  

5. To modify other options, repeat steps 3 and 4. 

6. Choose Update to update the settings in the 3DStairs/Settings menu. 

The stair calculator only accepts a whole number of treads or risers as a result. If the values 
you enter in a calculation result in a fractional solution, the stair calculator modifies the values.  

Total
Rise

Riser
Height

Bottom Landing

Top Landing

1

2

3

4

5

6

7

Number of Risers = 7

 

Total rise, riser height, and number of risers 
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Total run, tread depth, and number of treads 

For example, to calculate the number of risers through changing RiserHgt: 

 Initial Settings Modified Settings Stair Calculator Results 
TotlRise 12’0” 12’0” 12’3” 
RiserHgt 6” 7” 7” 
#Risers 24 20.57 21 

 
Because #Risers is a fractional number, the Stair Calculator automatically adjusts the 
TotlRise so that the results are whole numbers. If you change TotlRise, Stair 
Calculator adjusts RiserHgt to find a whole number solution. 
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AEC Modeler 
The AEC Modeler tool focuses on all aspects of door and window modeling, 
offering you simplified creation of 3D model components, while reducing creation 
time. Specifically, AEC Modeler allows you to set component dimension 
specifications and placement for windows and doors. To use the AEC Modeler, 
choose Toolbox from the Edit menu and then choose AEC_MODL from the Toolbox 
dialog box. 

The AEC Modeler Template library speeds the design process by storing, retrieving, 
and viewing frequently used designs and modifications in the Template library. 
Quick access to a variety of detailed models, and the ability to modify them or insert 
them into projects, creates many new possibilities. 

There are two view options available with this tool: plan and elevation.  

Using the In Plan option, you can create entities in the Plan view and view a 
component as if you were looking at it from the top down. You must be in a parallel 
view (as assigned in the 3DViews menu) to select this option. When creating 
entities, the entry points you assign specify the width and wall thickness. The 
height of the component is determined by the Sill Hgt and Head Hgt options. 

Using the In Elev option, you can create entities in an Elevation view and view a 
component as if you were looking at it from the side. You must be in a parallel view 
(as assigned in the 3DViews menu) to select this option. When creating entities, the 
entry points you assign specify the width and height, while you assign wall 
thickness (depth) in a menu. Any designs made in this view must be checked for 
coincidence of the wall and plane; otherwise, a lack of screen depth perception 
could cause placement outside the wall dimensions. 

When using In Elev, you must first place the inner surface of the wall in the plane of 
the screen. You can do this using either the Elevation/NewElev or PlneSnap options 
in the 3DViews menu. When working with this option, you are defined as being 
outside the room (exterior), looking in. Therefore, snap to points on interior wall 
surfaces. 
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Additionally, the following four options appear in many of the Windows and Doors 
menus: 

Color Sets or resets the representative color for any modeling component; see 
“Color Menus” in “The Drawing Board” chapter for more information 

LineWgt Sets the line width (weight) for any modeling component that appears 
on screen or on printed or plotted output; choose LineWgt, and then 
choose or type a value and press (Enter) 

LineType Sets the representative line to solid, dotted, dashed, or dot-dashed 

Spacing Sets the line spacing between dots, dashes, and so on; choose Spacing, 
and then choose or type a value and press (Enter) 

In addition to the Windows and Doors menus, AEC Modeler has several other 
options.  

Cutouts creates an opening in a wall according to head height and sill height 
settings. When you choose Cutouts from the AEC_MODL menu, the following 
options appear: 

Head Hgt Sets the head height; choose or type a value and press (Enter) 

Sill Hgt Sets the sill height choose or type a value and press (Enter) 

LyrSrch Places cutouts in walls on layers other than the active layer 

You can use Remove to remove a window, door, or cutout from a wall. If CutWall 
was used when creating the window, door or cutout, Remove also removes the void 
in the wall. 

The Hide, 3DViews, and 3DEntity options are shortcuts to those menus. See the “3D 
Viewing” chapter for information on the Hide and 3DViews menus. See the “3D 
Drawing” chapter for information on the 3DEntity menu. 

Modeling Windows 
The Windows menu in AEC_MODL serves as the master level for accessing all 
three-dimensional window component groups. You can access window data, load 
and save previously designed windows, and select or enter window components 
and data. 

All windows open outward, away from you. 

Cutting Walls 
CutWall is a toggle used to automatically create voids in slabs for windows. It is 
available in the Windows menu when InPlan is toggled on. When CutWall is 
toggled on, a LyrSrch toggle also becomes available. 
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Window Files 
The WndwFile option is a convenient way to expand on initial template designs, 
tailoring the product to your needs. The files then become additional resources for 
quick recall. The WndwFile menu options include: 

LoadWind Loads window settings from saved files; select or type a window 
filename and press (Enter); the window appears with all previously 
saved settings 

SaveWind Saves window settings to a file; type the filename and press (Enter) 

DelWind Deletes saved window files from the hard disk. To help prevent 
accidental deletions, the system prompts you for the name of the file 
you want to delete. Select the file you want to delete and press (Enter). 
Choose Yes to delete the window file; otherwise choose No. 

RenWind Renames existing files; select a file to rename, type a new filename of 
up to eight characters long, and press (Enter) 

CopyWind Copies the contents of an existing window file to a new file; select the 
file to copy from and press (Enter), then type the file to copy to and 
press (Enter) 

Form Displays a window data form  

Window Forms 
With the WndwForm option, you can view the settings for the current window. The 
design form offers a comprehensive view of the window parameters on one screen. 
These window parameters are divided into ten major groups.  

To save Form settings, press (Esc). 

Saving Windows as Symbols 
Use the Template option to create and save windows as symbols, developing a 
library of window symbols that you can add quickly to new projects. 

This Template option is a shortcut to the Template menu. See “Templates and 
Symbols” in the “Drawing Elements” chapter for more information. 
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Window Height and Wall Thickness 
You can set the head height and sill height of a window with the Head Hgt and Sill 
Hgt options, as well as use the Wall Thk option to change the wall thickness. The 
Head Hgt and Sill Hgt options only appear when In Plan is toggled on, while Wall 
Thk is only available when In Elev is toggled on. When you choose Head Hgt, sill 
Hgt, or Wall Thk, a list of values is displayed. Choose or type a new value and press 
(Enter). 

The Head Hgt and Sill Hgt settings are relative to Z-base. 

Window Types 
The UnitType menu displays available window types. Hinged window types open 
outward, away from the designer. Sliding windows, when viewed from the interior 
design position, have a fixed sash on the right and a movable sash on the left.  

Choose from the following window types: 

Fixed Windows with fixed panes of glass 

Casement Casement windows 

Awning Awning windows, hinged at the top 

Hopper Hopper windows, hinged at the bottom 

DblHung Double-hung windows 

Sliding Sliding windows 

% open Determines the amount that the window appears open in the model, 
with 0% being fully closed and 100% being fully open 
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Window Casings 
The Casing option controls the casing or exterior window group. You can set any of 
the following window casing options: 

AtHead Models casing elements at the window header 

Width Sets the casing width at the window header, the window jamb, and the 
sill across the window plane; choose the Width option under AtHead, 
AtJamb, or AtSill, and then choose or type a width and press (Enter) 

Thicknss Sets the casing thickness at the window header, the window jamb, and 
below the sill; choose or type a thickness and press (Enter) 

Extensn Sets the extension length past the outside edge of the vertical casing 
components (jamb casing) and past the outside edge of the vertical 
jamb casing component to the sillChoose or type an extension length 
and press (Enter). For any extension, the measurement is always 0 when 
the outside edge of the vertical casing and the extension end are 
aligned. Positive numbers indicate an extension; negative numbers 
indicate a setback. 

AtJamb Models the casing element at the jamb (Width and Thicknss appear 
again below AtJamb) 

AtSill Models the casing elements below the sill. (Width, Thicknss and 
Extensn appear again below AtSill) 

  

Window casing 
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Window Trim 
Use Trim to control the trim or interior window component group. You can vary 
elements, such as the trim apron, according to aesthetic preference or design 
requirements: 

AtHead Models trim elements at the window header 

Width Sets the trim width at the window jamb, across the window jamb; 
choose or type a value and press (Enter) 

Thicknss Sets the trim thickness at the window jamb and the window sill; 
choose or type a value and press (Enter) 

Extensn Sets the trim extension length past the outside edge of the vertical jamb 
trim components (jamb casing) or past the outside edge of the vertical 
jamb casing component of the sill; choose or type a value and press 
(Enter). For any extension, the measurement is always 0 when the 
outside edge of the vertical casing and the extension end are aligned. 
Positive numbers indicate an extension; negative numbers indicate a 
setback. 

AtJamb Models trim elements at the jamb (Width and Thicknss appear again 
below AtJamb) 

AtSill Models trim elements at the sill (Width, Thicknss and Extensn appear 
again below AtSill) 

  

Window trim 
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Window Headers 
The Head option lets you define the window header, or top of the frame. This area 
can become exceedingly detailed in a model rendering, with the inclusion of its 
structural and aesthetic elements in one master group. You can individually set the 
following components to provide a clearer view: 

Do Head Models the header component 

HeadWdth Sets the header width. Measure through the wall, from the inner 
surface of the wall, outward. This option appears when WalWdth is 
off. When you choose HeadWdth, a list of header width values 
appears. Choose or type a header width and press (Enter). 

Head Thk Sets the window header thickness. Measure from top, the wall 
opening, to bottom. When you choose Head Thk, a list of header 
thickness values appears. Choose or type a header thickness and press 
(Enter). 

WalWdth Calculates the header width equal to the thickness of the wall. When 
WalWdth is off, the width of the head is controlled by the header 
width setting. 

  

Window header 
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Window Jambs 
Use the following Jamb options to define the window jamb: 

Do Jamb Models jamb components 

JambWdth Sets the jamb width. Measure through the wall from the inner surface 
of the wall, outward. This option appears when WalWdth is off. 
Choose JambWdth, and then choose or type a jamb width and press 
(Enter). 

Jamb Thk Sets the jamb thickness. Measure from the void edge, or wall opening, 
inward toward the window center along the wall plane. Choose Jamb 
Thk, and then choose or type a jamb thickness and press (Enter). 

WalWdth Sets the wall width. When this toggle is off, the width of the jamb is 
controlled by JambWdth. 

  

Window jamb 
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Window Sills 
Sill lets you define the window sill. The sill is not broken down into stool (interior) 
and finish (exterior) sill components. Also, the sill horns are proportionate and do 
not carry different lengths on the interior and exterior extensions. 

Do Sill Models the sill 

Thicknss Sets the sill thickness from the bottom of the window opening, 
upward; choose Thicknss, and then choose or type a sill thickness and 
press (Enter) 

In Extn Sets the inside sill extension away from the plane of the wall toward 
the center of the room; choose In Extn, and then choose or type an 
inside sill thickness and press (Enter) 

Out Extn Sets the outside sill extension away from the plane of the wall 
outward; choose Out Extn, and then choose or type an outside sill 
extension and press (Enter) 

SideExtn Sets the inside and outside (sill horn) extensions from the sides of the 
window opening, outward, along the plane of the wall; choose 
SideExtn, and then choose or type a side extension and press (Enter) 

  

Window sill 
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Window Sashes 
Sash defines the window sash assembly. The sash is the frame that holds the 
muntins and glass; without it, the muntins and glass would be suspended in 3D 
space. Single pane or double thermopane windows, while not having muntins, 
must have Centred toggled on to function within the confines of the wall plane.  

Do Sash Models the sash components; when Do Sash is off, muntins and glass 
are not added to the drawing even if DoMuntn and DoGlass are on 

SashWdth Sets the sash width for all components (top and bottom rails and 
stiles); choose SashWdth, and then choose or type a sash width and 
press (Enter) 

SashThk Sets the sash thickness for all sash components; choose SashThk, and 
then choose or type a sash thickness and press (Enter) 

Centred Centers a sash within the window frame. Centred and Offset are 
mutually exclusive; only one can be toggled on at any given time 

Offset Determines the sash offset placement from the inside of the window 
jamb. The distance is from the interior surface of the wall to the interior 
surface of the sash; choose Offset, and then choose or type a sash offset 
and press (Enter) 
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Muntins 
Use Muntins to define and place window pane dividers within the sash assemblies. 
You can also set the number of window panes and their placement.  

DoMuntn Models muntins, or window pane dividers 

MuntWdth Sets the muntin width along the plane of the wall; the width applies 
equally to vertical and horizontal muntins; choose MuntWdth, and 
then choose or type a muntin width and press (Enter) 

MuntThk Sets the muntin thickness, which is measured through the window; 
choose MuntThk, and then choose or type a muntin thickness and 
press (Enter) 

PaneHorz Sets the number of panes per window horizontally; choose PaneHorz, 
and then choose or type a value and press (Enter) 

PaneVert Sets the number of panes per window vertically; choose PaneVert, and 
then choose or type a value and press (Enter) 

PaneHorz and PaneVert are also available in the Glass menu. They are the same settings, so 
when you change either option in the Muntins menu, the new values are also displayed for the 
PaneHorz and PaneVert options in the Glass menu. 

Centred Centers a muntin within the sash; Centred and Offset are mutually 
exclusive; only one can be toggled on at any given time 

Offset Sets the offset placement of the muntins from the interior surface of the 
sash to the interior surface of the muntins; choose Offset, and then 
choose or type a muntin offset and press (Enter); Centred and Offset are 
mutually exclusive; only one can be toggled on at any given time 

FullEdg Sets a full-edge muntin at the window sash 

HalfEdg Sets a half-edge muntin at the window 

No Edg Sets a no-edge muntin at the window sash 

Slabs Constructs muntins as slabs; when Slabs is toggled off, muntins are 
constructed as 3D lines 
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Glass 
Use Glass to define the number of glass panes horizontally and vertically. It also sets 
the glass thickness for the window panes in the model. Since glass is represented as 
a slab or solid object, it is often left out of a model so that a hidden line removal can 
be performed as if the glass were transparent.  

DoGlass Models window glass in the window panes 

GlassThk Sets the glass thickness; choose GlassThk, and then choose or type a 
glass thickness and press (Enter) 

PaneHorz Sets the number of horizontal panes per window; choose PaneHorz, 
and then choose or type a value and press (Enter) 

PaneVert Sets the number of vertical panes per window; choose PaneVert, and 
then choose or type a value and press (Enter) 

PaneHorz and PaneVert are also available in the Muntins menu. They are the same settings, 
so when you change either option in the Glass menu, the new values are also displayed for 
the PaneHorz and PaneVert options in the Muntins menu. 

Centred Centers a window pane glass in the muntin, through the window; 
Centred and Offset are mutually exclusive; only one can be toggled on 
at any given time 

Offset Sets the offset of the glass panes from the interior surface of the muntin 
to the interior surface of the glass; choose Offset, and then choose or 
type a glass pane offset and press (Enter); Centred and Offset are 
mutually exclusive; only one can be toggled on at any given time 

Modeling Doors 
The Doors menu lets you access door data, load or save previously designed doors, 
and select or enter door components and data.  

Cutting Walls 
CutWall is a toggle used to automatically create voids in slabs for doors. It is 
available in the menu when InPlan is toggled on. When CutWall is toggled on, a 
LyrSrch toggle also becomes available. 
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Door File 
Use the DoorFile option to load, save, delete, rename, or copy door files. Choose 
from the following DoorFile options: 

LoadDoor Loads door parameters from saved files; choose or type a door 
filename and press (Enter) 

SaveDoor Saves door parameters to a file; type a filename and press (Enter) 

Del Door Deletes saved door files from the hard disk. To help prevent accidental 
deletions, the system prompts for the filename requested. To delete a 
door file, select a filename and press (Enter). Choose Yes to delete the 
file; otherwise choose No.  

Ren Door Renames existing files; select a file to rename, type a filename of up to 
eight characters long, and press (Enter) 

CopyDoor Copies the contents of an existing door file to a new file; type the name 
of the file to copy from and press (Enter), then type the filename to copy 
to and press (Enter) 

Form Displays a door data form 

All doors are created to open inward, toward you. 

Door Forms 
The DoorForm menu lets you view the settings for the door on which you are 
currently working. The design form offers a comprehensive view of the door 
parameters on one screen. 

Saving 3D Doors as Symbols 
Use the Template option to create and save doors as symbols, developing a library 
of door symbols that you can quickly insert into new projects. For more 
information, see “Templates and Symbols” in the “Drawing Elements” chapter. 

Door Heights and Wall Thickness 
You can set the head height and sill height of a door with the Head Hgt and Sill Hgt 
options, as well as use the Wall Thk option to change the wall thickness. The Head 
Hgt and Sill Hgt options are available only when In Plan is toggled on, while Wall 
Thk is only available when In Elev is toggled on. When you choose one of these 
options, a list of values is displayed in the Menu Window. Choose or type a new 
value and press (Enter). 

The Head Hgt and Sill Hgt settings are relative to Z-base. 
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Door Types 
UnitType displays available door types. Doors swing inward (toward you), so you 
should build designs from the interior of a structure. 

Choose a door type from the following options: 

Single Single door, hinged 

Double Double doors, hinged 

Bifold Bi-fold door 

2xBifld Double bi-fold doors 

Sliding Sliding door 

Pocket Pocket doors 

% open Determines the percentage that a door appears open in the model, 
with 0% being fully closed and 100% being fully open 
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Door Casings 
Use Casing to control the casing or exterior door component group. You can set any 
of the following door casing options: 

At Head Models casing elements in the door header model 

Width Sets the casing width at the door header, across the door plane, and at 
the door jamb; choose or type a value and press (Enter) 

Thicknss Sets the casing thickness at the door head and at the door jamb; choose 
or type a value and press (Enter) 

Extensn Sets the extension length past the outside edge of the vertical casing 
components (jamb casing). Choose or type a value and press (Enter). For 
any extension, this measurement is always 0 when the outside edge of 
the vertical casing and the extension end are aligned. Positive numbers 
indicate an extension; negative numbers indicate a setback. 

At Jamb Models casing elements in the door jamb model (Width and Thicknss 
appear again after this option) 

  

Door casing 
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Door Trim 
Use Trim to control the trim, or interior door component group. You can vary such 
elements as the trim apron, according to aesthetic preference or design 
requirements.  

At Head Models trim elements at the door header model 

Width Sets the trim width at the door header and across the door jamb 

Thicknss Sets the trim thickness at the door header, through the door, and at the 
door jamb 

Extensn Sets the trim extension length past the outside edge of the vertical jamb 
trim components 

At Jamb Models trim elements in the door jamb model (Width and Thicknss 
appear again after AtJamb) 

  

Door trim 
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Door Headers 
Use Header to define the door header. This area can become exceedingly detailed in 
a model rendering, including its structural and aesthetic elements in one master 
group. With Header you can break down the various components to provide a 
clearer view. 

Do Head Models the door header 

HeadWdth Sets the door header width. Measure through the door, from the inner 
surface of the door outward. This option appears when WalWdth is 
off; choose HeadWdth, and then choose or type a header width and 
press (Enter) 

HeadThk Sets the door header thickness. Measure from top (wall opening) to 
bottom. When you choose HeadThk, a list of thickness values appears. 
Choose or type a header thickness and press (Enter). 

WalWdth Calculates a header width equal to the wall thickness; when WalWdth 
is off, the width of the header is controlled by the header width 
(HeadWdth) setting 

  

Door header 
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Door Jambs 
The Jamb menu defines the door jamb, using the following options: 

Do Jamb Models jamb components 

JambWdth Sets the door jamb width (measure from the inner surface of the door, 
outward through the door); available only when WalWdth is off; 
choose JambWdth, and then choose or type a jamb width and press 
(Enter) 

Thicknss Sets the door jamb thickness (measure from the void edge, or wall 
opening, inward toward the door center along the wall plane); choose 
Thicknss, and then choose or type a jamb thickness and press (Enter) 

WalWdth Sets the jamb width equal to the wall width; when WalWdth is off, the 
width of the jamb is controlled by JambWdth; choose WalWdth, and 
then choose or type a jamb width and press (Enter) 

  

Door jamb 
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Door Sills 
The Sill menu defines the door sill, using the following options: 

Do Sill Models the sill 

Thicknss Sets the sill thickness from the bottom of the door opening, upward at 
the sill middle; choose Thicknss, and then choose or type a sill 
thickness and press (Enter) 

EdgeThk Sets the thickness of the tapered edge; choose EdgeThk, and then 
choose or type an edge thickness and press (Enter) 

InExtn Sets the inside sill extension away from the plane of the door toward 
the center of the room; choose InExtn, and then choose or type an 
extension and press (Enter) 

Out Extn Sets the exterior sill extension across the door plane from the exterior 
wall outward; choose Out Extn, and then choose or type an extension 
and press (Enter) 

SideExtn Sets the exterior sill extension along the wall plane from the outside 
edge of the trim outward (also known as the “sill horns”); choose 
SideExtn, and then choose or type an extension and press (Enter) 

  

Sill thickness 
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Door Stops 
Use Stop to place and size the door stops. The stop is drawn to the exterior of the 
door, whether the door is flush or offset. Door stops are not created for sliding or 
pocket doors, regardless of whether Do Stop is toggled on or not. 

Do Stop Models the door stop 

StopWdth Sets the stop width for all components (measure the stop width in the 
same direction as the jamb width and across the wall plane); choose 
StopWdth, and then choose or type a stop width and press (Enter) 

Stop Thk Sets the stop thickness dimension (measure the stop thickness in the 
same direction as the jamb thickness and across the wall plane); choose 
Stop Thk, and then choose or type a stop thickness and press (Enter) 

Door Options 
The Door menu sizes, positions, and hinges a door, using the following options: 

Do Door Models the door 

Door Thk Sets the door thickness; choose Door Thk, and then choose or type a 
door thickness and press (Enter) 

HingRht Hinges doors on the right; determine the right side of the door by 
standing inside the structure and looking at the door 

HingLft Hinges doors on the left; determine the left side of the door by 
standing inside the structure and looking at the door 

Flush Sets the door flush with the outside wall 

Offset Sets the offset placement of the door from the interior wall surface 
across the wall plane; choose Offset, and then choose or type a value 
and press (Enter) 
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Door Knobs 
Use Knob to place, size, and identify the door knob; only round door knobs are 
available. When Do Door is off, you can’t create a knob regardless of the Do Knob 
setting. 

Do Knob Models the knob 

Diameter Sets the diameter of the door knob; choose Diameter, and then choose 
or type a door knob diameter and press (Enter) 

Extnsion Sets the knob extension out from the door; choose Extnsion, and then 
choose or type a knob extension and press (Enter) 

Knob Hgt  Sets the height of the knob from the bottom of the door; choose Knob 
Hgt, and then choose or type a knob height and press (Enter) 

Offset Sets the knob offset from the door edge; choose Offset, and then 
choose or type a knob offset and press (Enter) 

Inside Models a knob on the door interior 

Outside Models the knob on the door exterior; Outside and Inside can be 
toggled individually or together 
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Concrete 
With the Concrete tool, you can add six different types of preconstructed concrete 
forms to your drawing or model. There are many options for each type of form, 
including altering each form’s overall dimensions. The six concrete forms in this 
macro include: 

• columns 

• inverted tees (girders) 

• standard beams (rectangular cross section) 

• I-beam forms (“I” cross section) 

• single tee forms 

• double tee forms 

All forms are added to your drawing as Slab entity types. Once you add a concrete 
form to your drawing, you can modify the model using any of the standard 
DataCAD editing features that operate on Slab entities, including Move, Copy, 
Rotate, Enlarge, Mirror, Erase, and Stretch. You can also use Voids and Partial in the 
3DEntity/Slab menu. 

Certain conventions and principles apply to the entering of all forms, except 
columns. These rules apply to the placement of long forms relative to two points 
indicating the beginning and end of a form. These two points form a line known as 
the defining line. 

The form can lie to the right, left, or center of the defining line in plan view. (You can 
position the defining line at Z-base or Z-height, relative to the plan.) You can 
position a form relative to this defining line in the Z direction or position the top, 
bottom, or center of the form to coincide with the defining line in the Z direction. 
These alternatives provide a total of 18 choices for the position of any given form, 
relative to the defining line. 

Columns begin as rectangular boxes. You can chamfer the vertical edges of the 
column and add up to four seats to the column to support the girders and beams. 
The location of a column is defined by two points, at opposite corners of a box, 
indicating the overall dimensions of the column. The column extends vertically 
from the current value of Z-base to the current value of Z-height. 
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è To draw columns: 

1. Choose Column from the Concrete menu. The following options are displayed: 

Width Sets the column width 

Depth Sets the column height 

Rotate Enters columns that rotate about the entry point; you are prompted for 
the rotation angle of the column 

LoLeft Specifies the location of the column by its lower left corner 

Center Specifies the location of the column by its center point 

UpRight Specifies the location of the column by its upper right corner 

TopSeat / BotSeat 
LftSeat / RhtSeat 

Indicate the side of the column where the column seat is; you are 
prompted for the height of the column seat from the current value of Z-
base (when a toggle is off, column seats are not added for that particular 
side) 

SeatOnly Adds column seats to an existing column or multiple sets of column 
seats to a single column in a multiple-story structure with monolithic 
concrete columns. When this toggle is on, you can add seats to a 
column, but you cannot add actual columns. 

SeatWdth  Sets the distance from the face of the column to the outside of the 
column seat 

SeatHght Sets the distance from the top face of the column seat to the bottom 
edge of the column seat 

Chamfer Chamfers the edges of the column; otherwise, the column is angular in 
cross section (the size of the column seats automatically adjusts) 

ChamSize Sets the size of the column chamfers 

2. Choose any options you want to set. When you choose Width, Depth, Rotate, 
TopSeat, BotSeat, LftSeat, RhtSeat, SeatWdth, and SeatHght a list of values 
appears. 

3. Choose or type a value and press (Enter). 

4. Select a point in the Drawing Window to place the column’s location. 
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Standard beams have a simple rectangular cross section, but they can also have 
chamfers along the four edges of the beam. You can vary the height and width of 
the beam. There are 18 possible ways to position the beam relative to a defining line 
that extends from the first point entered to the second point entered. 

è To draw a standard beam: 

1. Choose Std Beam from the Concrete menu. The following options are displayed: 

Width Sets the beam width 

Depth Sets the beam depth 

Chamfer Chamfers the beam on all edges; otherwise, the beam is rectangular in 
the cross section. When Chamfer is on, you must enter the chamfer 
size.  

Left Draws the form to the left of the defining line in the X-Y plane 

Center Draws the form centered about the defining line in the X-Y plane 

Right Draws the form to the right of the defining line in the X-Y plane 

Top Draws the form with its top aligned to the defining line 

Center Draws the form with its center aligned to the defining line 

Bottom Draws the form with its bottom aligned to the defining line 

Z-Base Sets the beam’s defining line at the Z-base 

Z-Hght Sets the beam’s defining line at the Z-height 

2. Choose any options you want to set. When you choose Width, Depth, and 
Chamfer, a list of values appears. Choose or type a value and press (Enter).  

3. Select the first end of the defining line. 

4. Select the second end of the defining line. 
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I-beams are similar to standard beams, except that the beam is narrower at the 
middle of the cross section than it is at either end of the cross section. For a typical 
application, the stresses in the concrete are much higher at the top or bottom of the 
beam; therefore, an I-beam can be more economical to use than a standard 
rectangular beam. 

è To draw an I-beam: 

1. Choose I-Beam from the Concrete menu. The following options are displayed: 

Width Sets the overall horizontal measurement of the cross section of the I-
beam 

Depth Sets the overall vertical measurement of the cross section of the I-beam 

WebThick Sets the thickness of the narrower portion of the beam independently 
of the overall width of the I-beam 

FlngDpth Sets the vertical dimensions of the I-beam flange independently of all 
other I-beam cross section dimensions 

Left Draws the form to the left of the defining line in the X-Y plane 

Center Draws the form centered about the defining line in the X-Y plane 

Right Draws the form to the right of the defining line in the X-Y plane 

Top Draws the form with its top aligned with the defining line 

Center Draws the form with its center aligned with the defining line 

Bottom Draws the form with its bottom aligned with the defining line 

Z-Base Sets the beam’s defining line at the Z-base 

Z-Height Sets the beam’s defining line at the Z-height 

2. Choose any options you want to set. When you choose Width, Depth, 
WebThick, or FlngDpth, a list of values appears. Choose or type a value and 
press (Enter). 

3. Select the first end of the defining line.  

4. Select the second end of the defining line. 
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Inverted tees, or girders, are typically used for supporting single or double tees 
across a long span such as a parking garage bay. Because they are in the shape of an 
inverted T, the beam portion of a single, double, or quad tee can be placed on a tee’s 
shelf. You have a variety of options for changing the overall dimensions of the beam 
and for its placement in your model. 

è To draw an inverted tee: 

1. Choose InvrtTee from the Concrete menu. The following options are displayed: 

OvrlHgh Sets the overall height of the inverted tee; choose OvrlHght, and then 
choose or type a value and press (Enter) 

OvrlWdth Changes the overall width of the inverted tee; choose OvrlWdth, and 
then choose or type a value and press (Enter) 

NtchDpth Changes the depth of the notch in the inverted tee; choose NtchDpth, 
and then choose or type a value and press (Enter) 

BeamThck Changes the thickness of the narrow portion of the inverted tee; 
choose BeamThck, and then choose or type a value and press (Enter) 

Left Draws the form to the left of the defining line in the X-Y plane 

Center Draws the form centered about the defining line in the X-Y plane 

Right Draws the form to the right of the defining line in the X-Y plane 

Top Draws the form with its top aligned with the defining line 

Center Draws the form with its center aligned to the defining line 

Bottom Draws the form with its bottom aligned to the defining line 

Z-Base Sets the defining line at the Z-base 

Z-Height Sets the defining line at the Z-height 

Single Places a shelf on only one side of the inverted tee (to the left of the 
defining line) on the end of the first inverted tee that is entered 

Double  Places shelves of identical size on both sides of the inverted tee 

2. Select the first end of the defining line. 

3. Select a second point that is the opposite end of the defining line. 
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Single tee concrete forms are used as combination beams and floor slabs. In 
applications where the primary function is creating floors, a double tee form is 
generally used. Industrial buildings and parking structures use double tees for 
upper floors that must support large floor loads. A double tee form is easier to 
position and place because of the stability provided by having two beam sections. 
Single tees are used in special cases, where spans are exceptionally long or floor 
loads are exceptionally high. In these cases, the weight and size of double tee forms 
can make them too large and heavy for practical fabrication, shipment, or 
placement. 

è To draw a single tee: 

1. Choose SnglTee from the Concrete menu. The following options are displayed: 

Width Sets the overall width of the single tee form (the location of the beam 
flanges of the form are automatically adjusted); choose Width, and 
then choose or type a width and press (Enter) 

Depth Sets the overall depth of the single tee form; choose Depth, and then 
choose or type a depth and press (Enter) 

WebThck Sets the thickness of the floor slab portion of the single tee form; 
choose WebThck, and then choose or type a thickness and press (Enter) 

BeamThck Sets the thickness of the two support beams for the single tee slab  

Left Draws the form to the left of the defining line in the X-Y plane 

Center Draws the form centered about the defining line in the X-Y plane 

Right Draws the form to the right of the defining line in the X-Y plane 

Top Draws the form with its top aligned to the defining line 

Center Draws the form with its center aligned to the defining line 

Bottom Draws the form with its bottom aligned to the defining line 

Z-Base Places the defining line at Z-base 

Z-Hght Places the defining line at Z-height 

2. Set the size of cross-sectional dimensions of the single tee form. 

3. Select the first end point of the defining line. 

4. Select the second end point of the defining line. 
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è To draw a double tee:  

1. Choose DbleTee from the Concrete menu. The following options are displayed: 

Width Sets the overall width of the double tee form (the location of the beam 
flanges of the form are automatically adjusted); choose Width, and 
then choose or type a width and press (Enter) 

Depth Sets the overall depth of the double tee form; choose Depth, and then 
choose or type a depth and press (Enter) 

WebThck Sets the thickness of the floor slab portion of the double tee form; 
choose WebThck, and then choose or type a thickness and press (Enter) 

BeamThck  Sets the thickness of the two support beams for the double tee slab; 
choose BeamThck, and then choose or type a thickness and press (Enter) 

Left Draws the form to the left of the defining line in the X-Y plane 

Center Draws the form centered about the defining line in the X-Y plane 

Right Draws the form to the right of the defining line in the X-Y plane 

Top Draws the form with its top aligned to the defining line 

Center Draws the form with its center aligned to the defining line 

Bottom Draws the form with its bottom aligned to the defining line 

Z-Base Places the defining line at Z-base 

Z-Hght Places the defining line at Z-height 

2. Set the size of the cross-sectional dimensions of the double tee form. 

3. Select the first end point of the defining line.  

4. Select the second end point of the defining line. 
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3D Framing 
FrameIt is a framing utility that helps you create three-dimensional floor, wall, and 
roof systems. Once you build framing members, use Extract to extract framing 
materials to print or save for use in the DataCAD Estimator. 

Floor Framing 

è To frame a floor: 

1. Choose Floors from the FrameIt menu.  

2. Verify settings for Plate, Joist, and SubFloor. See “Sill Plate, Joist, and Sub-Floor 
Settings” below for more information. 

3. Choose either Center or Sides to define the floor boundary from the center line 
of the vertical member or from one side of the floor to the other. 

4. Define the floor to frame by defining a floor boundary or by choosing Select and 
selecting an existing floor boundary. To define the floor boundary, object snap to 
each point of the floor boundary, tracing the floor. 

5. Choose Opening to define floor openings, such as chimneys or stairs. Select the 
first point of the floor opening, move the mouse to stretch the rubberband box 
around the opening, and select the second point of the rubberband box to define 
the floor opening. 

6. Choose Beam to define beam style and location. Set the following options as 
necessary: 

Single Models single beams 

Double Models double beams 

Custom Customizes the number of entities that make up a beam 

Color Assigns a beam color; see “Color Menus” in “The Drawing Board” 
chapter for more information about how to choose a color 

Size Sets a beam size (choose Change to change a standard lumber size in 
the menu) 

Flush Positions the top of the beam flush or equal to the top of the joist 

Below Positions the top of the beam equal to the bottom of the joist 

Change Changes the current framing member attributes (those attributes set 
when you selected or defined the floor boundary) 

FileI/O Accesses file options to save the current framing settings in a file, load 
saved settings, or delete or rename framing settings files 
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7. To make any changes before choosing Build, choose Edit or Change to access 
DataCAD editing options, including Move, Copy, Rotate, Mirror, Stretch, 
Enlarge, Erase, and Layers, or to globally change any floor member attributes. 

If you choose Edit or Change, you must choose Build again for those changes to take effect. 

8. To save floor settings to a file, choose SaveFile from the FileI/O menu. 

9. Choose Build and select the boundary on which to generate a floor system. 
Build generates a framing system based on the settings you defined above. For 
more information on using the selection menu to select the boundary to frame, 
see the “The Drawing Board” chapter. 

Use the following toggles before you select the boundary to frame for added 
control over the Build process: 

SchemLyr Builds framing members on the schematic layer 

ActvLyr Builds framing members on the active layer 

FlrsOnly Builds only floors with the current settings; otherwise, DataCAD 
builds all members; only available in the Floors/Build menu 

WalsOnly Builds only walls with the current settings; otherwise, DataCAD 
builds all members; only available in the Walls/Build menu 

RfsOnly Build only roofs with the current settings; otherwise, DataCAD builds 
all members; only available in the Roofs/Build menu 

10. When framing is complete, you have access to the following DataCAD options: 
3DViews, Hide, and Layers. See the “3D Viewing” and “Before You Draw” 
chapters for more information on these options. 

11. Choose Exit to return to the Floors menu. 

Sill Plate, Joist, and Subfloor Settings 
Use Plate to set the following sill plate options: 

DoPlate Models sill plates 

Single Models single plates 

Double Models double plates 

Custom Customizes the number of entities that make up the plate 

Color Assigns a plate color; see “Color Menus” in “The Drawing Board” 
chapter for more information about how to choose a color 

Size Sets a plate size; choose Change to change a standard lumber size in 
the menu 
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Use Joist to set the following joist options:  

DoJoist Models the joists 

Size Assigns a joist size, or defines a custom joist size; choose Change to 
change a standard lumber size in the menu 

Spacing Assigns joist spacing (measure spacing from the center line of one joist 
to the center line of the next joist) 

Color Assigns a joist color; see “Color Menus” in “The Drawing Board” 
chapter for more information about how to choose a color 

Angle  Changes the angle in which your joist member will be modeled within 
the schematic 

 

Use SubFloor to set the following subfloor options:  

DoSubflr Models the subflooring 

Single Models single layer subfloors 

Double Models double layer subfloors 

Custom Customizes the number of entities that make up a subfloor 

Color Assigns a subfloor color; see “Color Menus” in “The Drawing Board” 
chapter for more information about how to choose a color 

Thicknss Sets the subfloor thickness for each layer 

Wall Framing 

è To frame a wall: 

1. Choose Walls from the FrameIt menu. 

2. Verify the settings for WallHght, Plate, and Stud. See “Wall Height, Plate, and 
Stud Settings” below for more information. 

3. Choose either Center or Sides to define the wall boundary from the center line of 
the vertical member or from one side of the wall to the other. 

4. Choose either Exterior or Interior. Use Exterior to create outside wall systems; 
DataCAD assumes this will be a closed boundary. Use Interior to create inside 
wall systems; DataCAD toggles Closed off and you are drawing a single or 
string-line wall that does not close itself. 
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5. Define the wall to frame by defining a wall boundary or by choosing Select and 
selecting an existing floor or wall boundary. If defining the roof by the boundary, 
object snap to the first point of the wall boundary to frame and continue tracing 
the boundary from that point. 

6. Choose Opening to define wall openings. Choose either Window or Door (for 
Exterior) or PassThru or Door (for Interior). If you choose Window or PassThru, 
verify the settings for SillHgt, HeadHght, and HeadStyl. For Door, define only 
HeadHght and HeadStyl. 

Window Defines window openings in the wall 

Door Defines door openings in the wall 

SillHght Defines the sill height; available only when Window is toggled on 

HeadHght Defines the header height of the door 

HeadStyl Defines the header style: 

Cripple Member with smaller studs that run from the top of the 
header to the bottom of the lower top plate; maintains stud 
spacing 

Boxed Solid member that runs from the top of the header to the 
bottom of lower top plate 

Change Changes any opening attributes 

FileI/O Accesses file options to save the current framing settings in a file, load 
saved settings, or delete or rename framing settings files 

7. To make any changes before choosing Build, choose Edit or Change to access 
DataCAD editing options, including Move, Copy, Rotate, Mirror, Stretch, 
Enlarge, Erase, and Layers, or to globally change any wall member attributes. 

If you choose Edit or Change, you must choose Build again for those changes to take effect. 

8. To save wall settings to a file, choose SaveFile from the FileI/O menu. 
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9. Choose Build and select the boundary on which to generate a wall system. Build 
generates a framing system based on the settings you defined above. For more 
information on using the selection menu to select the boundary to frame, see the 
“The Drawing Board” chapter. 

Use the following toggles before you select the boundary to frame for added 
control over the Build process: 

SchemLyr Builds framing members on the schematic layer 

ActvLyr Builds framing members on the active layer 

FlrsOnly Builds only floors with the current settings; otherwise, DataCAD 
builds all members; only available in the Floors/Build menu 

WalsOnly Builds only walls with the current settings; otherwise, DataCAD 
builds all members; only available in the Walls/Build menu 

RfsOnly Build only roofs with the current settings; otherwise, DataCAD builds 
all members; only available in the Roofs/Build menu 

10. When framing is complete, choose Exit to return to the Walls menu. 

Wall Height, Plate, and Stud Settings 
Use WallHght to set wall height options. Choose a wall height from the list or type a 
wall height and press (Enter). 

 

Use Plate to set the following top and bottom plate options: 

DoTop Models top plates 

Single Models single top plates 

Double Models double top plates 

Custom Customizes the number of entities that make up a top plate 

Color Assigns a top plate color; see “Color Menus” in “The Drawing Board” 
chapter for more information about how to choose a color 

DoBottom Models bottom plates 

Single Models single bottom plates 

Double Models double bottom plates 

Custom Customizes the number of entities that make up a bottom plate 

Color Assigns a bottom plate color; see “Color Menus” in “The Drawing 
Board” chapter for more information about how to choose a color 

 



3D Framing 

 536  / 3D Modeling

Use Stud to set vertical framing member options: 

DoStud Models the vertical stud member 

Size Assigns a stud size or defines a custom stud size 

Spacing Assigns stud spacing (measure spacing from the center line of one 
stud to the center line of the next stud) 

Color Assigns a stud color; see “Color Menus” in “The Drawing Board” 
chapter for more information about how to choose a color 

Roof Framing 
Use Roof Framing to create three-dimensional roof framing systems. You can frame 
the following roof types: Shed, Gable, Hip, and Gambrel. See “3D Roofs” in this 
chapter for a description of each roof type.  

è To frame a roof: 

1. Choose Roofs from the FrameIt menu. 

2. Choose the roof type to frame: Shed, Gable, Hip, or Gambrel. 

3. Choose Settings to set the options for roof settings, including pitch, purlin 
height, rafters, sheathing, and overhang. See “Settings” below for more 
information. 

4. Define the roof by defining a roof boundary or by choosing Select and selecting 
an existing wall or roof boundary. To define the roof with an existing boundary, 
choose that boundary and continue with step 6. To define the roof by a 
boundary, object snap to the first and second corners of the roof boundary to 
define the length of the roof parallel to the ridge. 

Make sure that you define the roof boundary at a Z-base set to the plate height of the wall. 

The following options appear on the menu: 

Closed Models a closed roof boundary 

Backup Backs up one roof corner so you can enter a new position 

Cancel Returns you to the FrameIt menu without defining a roof perimeter 

Close/Exit Stops defining the roof perimeter 

5. If defining the roof by the boundary, choose the third corner of the roof 
perimeter to define the width of the roof perpendicular to the ridge. The roof 
boundary is calculated and closed. 
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6. Choose Opening to define roof openings, such as chimneys. Select the first point 
of the roof opening, move the mouse to stretch the rubberband box around the 
opening, and select the second point of the rubberband box to define the roof 
opening. 

7. To make any changes before choosing Build, choose Edit or Change to access 
DataCAD editing options, including Move, Copy, Rotate, Mirror, Stretch, 
Enlarge, Erase, and Layers, or to globally change any roof framing member 
attributes. 

If you choose Edit or Change, you must choose Build again for those changes to take effect. 

8. To save roof settings to a file, choose SaveFile from the FileI/O menu. 

9. Choose Build and select the boundary on which to generate a roof system. Build 
generates a framing system based on the settings you defined above. When you 
define a roof boundary, FrameIt bases the plate height on the current Z-Base 
setting. When you use Select to select an existing wall boundary, FrameIt uses 
the plate height of the wall.  

FrameIt always centers ridge boards when framing roofs. 

10. When framing is complete, choose Exit to return to the Roofs menu. 

Settings 
Use Pitch to set a pitch for Shed, Gable, and Hip roofs. Pitch is defined by rise and 
run; choose a pitch from the menu, or choose Custom, type a pitch, and press (Enter). 
Use UprPitch and LwrPitch to set the pitch for the upper and lower sections, 
respectively, of a Gambrel roof. 

Use MidRdgHt to set the height for purlins for Gambrel roofs. Choose a height from 
the menu, or choose Custom, type a height, and press (Enter).  
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Use Rafters to set the following rafter options: 

DoRafter Models rafters; models collar ties every four feet 

Size Sets a rafter size from the list, or defines a custom rafter size 

Spacing Sets rafter spacing or defines custom rafter spacing (measure spacing 
from the center line of one rafter to the center line of the next rafter) 

Color Sets a ridge board and rafter color; see “Color Menus” in “The 
Drawing Board” chapter for information about how to choose a color 

EaveSqr Models fascia square to the angle of the rafter 

EavePlmb Models fascia parallel to the wall 

BrdMouth Assigns a Bird’s Mouth dimension; choose a dimension from the 
menu, or choose Custom, type a dimension, and press (Enter) 

Use Sheathng to set the following roof sheathing options: 

DoSheath Models roof sheathing 

Single Models single layer roof sheathing 

Double Models double layer roof sheathing 

Custom Models a custom number of roof sheathing layers 

Color  Assigns a roof sheathing color; see “Color Menus” in “The Drawing 
Board” chapter for more information about how to choose a color 

Thicknss Assigns the thickness of the roof sheathing material or defines a 
custom thickness 

Use the following OverHang options to set the overhang distance. Measure 
OverHang from the outside face of the sheathing to the outside face of the rafter. 

EaveOhng Assigns an overhang distance at the eave 

RakeOhng Assigns an overhang distance on the gable end 

File Options 
Use FileI/O to access file options: 

LoadFile Loads a previously saved file of floor, wall, or roof framing settings 

SaveFile Saves the current framing settings in a file 

DelFile Deletes an existing file of framing settings 

Rename Renames an existing file of framing settings 
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Extracting Framing Materials 
Use Extract to extract framing materials to print or save for use in DataCAD 
Estimator. Before you choose Extract, toggle on the layer containing the framing 
members to extract. A Framing Member Takeoffs list appears showing the Usage, 
Size, Unit, and Quantity of any framing members that exist on layers toggled on. 

è To extract framing materials: 

1. Choose Extract from the FrameIt menu. 

2. Choose Yes to begin the extraction; otherwise choose No. 

Resetting Framing Settings 

è To reset all of the framing settings to their default values, clearing all your values: 

1. Choose Reset from the FrameIt menu. 

2. Choose Yes to reset all settings; otherwise choose No. 
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3D Roofs 
RoofIt automates the construction of 3D roof models. You define the roof boundary 
and RoofIt automatically calculates and constructs a roof based on your settings. 

The standard roof types available with RoofIt are Gable, Hip, Boston, Gambrel, 
Mansard, and Shed. You can also create your own customized roof shape. You can 
vary the pitch, overhang, and plate height settings, and specify the type of soffit and 
fascia you want to model. RoofIt also lets you join a new roof to an existing roof. 
You can create dormers or other complex roof shapes using this feature.  

A complete roof model is composed entirely of 3D polygons. Because of this, you can easily 
process the model with DataCAD’s hidden line removal feature, Hide. 

 

Standard roof types 

è To create a roof model: 

1. Choose RoofIt from the Toolbox menu. The following options are displayed: 

RectRoof Constructs an orthogonal (rectangular) roof with no variation in 
settings; RectRoof is the easiest way to model a rectangular roof 

PolyRoof Constructs a polygonal roof that is not orthogonal or a roof that has 
varied pitch, overhang, or plate height settings 

RectRoof and PolyRoof are mutually exclusive; only one option will be displayed in the menu 
at any given time. If RectRoof is displayed in the RoofIt menu, clicking on it will change it to 
PolyRoof, putting DataCAD in polygonal roof drawing mode; you can begin drawing polygonal 
roofs. To change back to rectangular roof drawing mode, click on the PolyRoof option to 
change it to RectRoof. 
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Gable Available roof type 

Hip Available roof type 

Boston Available roof type 

Gambrel Available roof type 

Mansard Available roof type 

Shed Available roof type 

Join Defines a Gable, Hip, or Shed roof that connects to an existing roof 
plane; the roof that you join onto may be any roof type you create 
using RoofIt 

Settings Sets roof options depending on the type of roof you’re drawing; see 
“Setting Options” later in this section 

PlatHgt Sets different plate height values for each roof line than what’s 
currently set in Settings/PlatHgt during PolyRoof creation; when 
PlatHgt is on, RoofIt prompts you for the plate height of each roof; 
only changes with Gable and Gambrel roofs 

Pitch Sets different pitch values for each roof line than what’s currently set in 
Settings/Pitch during PolyRoof creation; when Pitch is on, RoofIt 
prompts you for the pitch of each roof side; only changes with Gable 
and Gambrel roofs 

Overhng Sets different overhang values for each roof line than what’s currently 
set in Settings/Overhng during PolyRoof creation; when Overhng is 
on, RoofIt prompts you for the overhang of each roof side; only 
changes with Gable, Gambrel, and Shed roofs 

Layers Shortcut to the Utility/Layers menu without exiting RoofIt; see 
“Layers” in the “Before You Draw” chapter for more information 

Hide Shortcut to the 3DEdit/Hide menu without exiting Roof It; see “Hide” 
in the “3D Viewing” chapter for more information 

3DViews Shortcut to  the 3DViews menu and look at your 3D model in different 
orientations without exiting RoofIt; see the “3D Viewing” chapter for 
more information 

3DEntity Shortcut to the 3DEntity menu without exiting RoofIt; see the “3D 
Drawing” chapter for more information 

2. Choose RectRoof or PolyRoof to define a rectangular or polygonal roof. See 
“Defining a Roof Boundary” below for more information. 

3. Choose one of the six standard roof types: Gable, Hip, Boston, Gambrel, 
Mansard, or Shed. 

4. Choose Join if you are defining a roof to join with an existing Gable, Hip, or 
Shed roof plane. 
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5. Choose Settings to set roof options (if you don’t need to vary any values, skip to 
step 6). Choose the option to set. These options vary depending on which roof 
type you selected in step 3. For a description of the Settings options see “Settings 
Options” later in this section.  

6. If you are creating a Gable, Gambrel, or Shed polygonal roof, you can choose 
PlatHgt, Pitch, or Overhng from the RoofIt menu to change that setting for each 
roof edge you draw. Once you select the first point of the roof boundary, you 
can’t move the control from one parameter to another. You can only change the 
value of one parameter as you define the roof boundary. 

7. Define a roof boundary by entering length and width values for a rectangular 
roof or by entering a series of four points for a polygonal roof. (For a more 
detailed explanation see “Defining the Roof Boundary” below.) 

8. If you are defining a roof to join choose the roof plane to join to when prompted. 

Defining the Roof Boundary 
The method you use to define the roof boundary depends on whether the RectRoof 
or PolyRoof option is displayed in the RoofIt menu. (The option that is displayed is 
the type of roof you’ll draw.) 

Rectangular Roofs 
When you model a rectangular roof, you define the roof shape by selecting points 
(in a clockwise direction) that define its length and width. This results in an 
orthogonal roof shape. 

è To define a rectangular roof boundary: 

1. If RectRoof is not displayed in the RoofIt menu, choose PolyRoof to toggle 
RectRoof on. 

2. Select the first point of the roof boundary; this point is the first point of the roof 
length, which runs parallel to the ridge of the roof. 

3. Select the second point of roof length.  

4. Select the third point of the roof boundary to define the roof width. The roof 
width is the distance from one side of the building to the other; this is 
perpendicular to the roof length and roof ridge. On a Shed roof, this point 
locates the ridge (minus the overhang). 
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Defining a rectangular roof boundary 

Polygonal Roofs 
To model a non-orthogonal roof or to model a roof with varying parameters 
(PlatHgt, Pitch, or Overhng), use PolyRoof. 

When you define a polygonal roof, you enter a series of four points. These points 
trace the edges of the roof boundary in a clockwise direction. The first and third 
edges of the boundary run parallel to the ridge; and the ridge bisects the second and 
fourth edges. Because the roof shape may be either orthogonal or non-orthogonal, 
the edges of the roof don’t have to be parallel and perpendicular to the ridge. 

è To define a polygonal roof boundary: 

1. If PolyRoof is not displayed in the RoofIt menu, choose RectRoof to toggle 
PolyRoof on. 

2. Select the first point of the roof boundary. This is the first point of the roof length. 

3. If you’re drawing a Gable, Gambrel, or Shed roof and you toggled PlatHgt, 
Pitch, or OverHng on in the RoofIt menu, RoofIt prompts you to enter the value. 
RoofIt applies this value to the first edge of the roof. 

4. Select the second point of the first roof edge. 

5. If you’re drawing a Gable, Gambrel, or Shed roof and you toggled Overhng on 
in the RoofIt menu, RoofIt again prompts you to enter a value. RoofIt applies 
this value to the second edge of the roof. 

6. Select the third point of the roof boundary. The second edge of the roof 
boundary is bisected by, but not necessarily perpendicular to, the ridge. The 
Shed roof is an exception; on a Shed roof, this point locates the ridge (minus the 
overhang). 
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7. If you’re drawing a Gable, Gambrel, or Shed roof and you toggled PlatHgt, 
Pitch, or OverHng on in the RoofIt menu, RoofIt prompts you to enter a value. 
RoofIt applies this value to the third edge of the roof.  

8. Select the fourth point of the roof; unless you toggled OverHng on in the RoofIt 
menu, the boundary closes and the roof model is constructed. 

9. If you toggled Overhng on, RoofIt prompts you to enter a value. RoofIt applies 
this value to the fourth edge of the roof. After you enter the value, the boundary 
closes and the roof model is constructed. 

 

Defining an orthogonal PolyRoof boundary 

  

Defining a non-orthogonal PolyRoof boundary 
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Joining Roofs 
Use Join to define a Gable, Hip, or Shed roof that connects to any one existing roof 
plane. The roof that you join onto may be any roof type created with RoofIt. 

The following example shows how to use RectRoof to join a Hip roof; you can also 
use PolyRoof. Define the roof boundary in a clockwise manner regardless of which 
input mode you use: RectRoof or PolyRoof. 

è To join two roofs: 

1. Model the first roof using the steps outlined at the beginning of this section. 

 

Defining the first boundary 

 

First boundary defined (plan view and perspective hidden-line image) 

2. Toggle Join on in the RoofIt menu. This tells RoofIt that the next roof you define 
will join onto an existing roof.  

3. Define the boundary of the second roof. RoofIt prompts you to select the roof 
plane to join onto.  

When defining the joining roof, if you selected any parameters to vary, RoofIt prompts you for 
values as outlined in the previous sections. 
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Join: Defining the second boundary 

4. Select a point within the perimeter of the roof plane to join to. RoofIt highlights 
the roof plane and starts the join operation. The roof you defined extends to and 
clips at the selected roof plane. 

  

Selecting roof plane to join 

   

Result of join (plan view and perspective hidden-line image) 
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Settings Options 
The options that appear in the RoofIt/Settings menu depend on the type of roof 
you’re drawing. The table below illustrates which settings appear for each roof type: 

 Gable Hip Boston Gambrel Mansard Shed 

PlatHgt X X X X X X 

Pitch X X X X X X 

MidRidge    X X  

2ndPitch    X X  

RoofThck X X X X X X 

Overhng X X X X X X 

GblOffst   X    

WallThck X X X X X X 

Fascia X X X X X  

EndWall X   X  X 

 

Settings options include: 

PlatHgt Sets the roof plate height; this value is an absolute Z-value and is not 
relative to the current Z-base and Z-height settings 

Pitch Sets the roof pitch in rise and run values (4:12, 5:12, 6:12, etc.); or enter 
a Custom pitch 

MidRidge Sets the purlin height on a Gambrel or Mansard roof; mid-ridge is a Z 
distance relative to the current PlatHgt setting 

2ndPitch Sets the second pitch on a Gambrel or a Mansard roof in rise and run 
values (4:12, 5:12, 6:12, etc.); or enter a Custom pitch 

RoofThck Sets the plate thickness of the roof 

Overhng Sets the roof overhang; measure overhang in the X, Y plane, from the 
roof definition boundary to the outermost point on the fascia 

GblOffst Sets the gable offset on a Boston roof; this distance is measured in the 
X, Y plane from the roof definition boundary to the exterior face of the 
gable end wall; only available when you choose to draw a Boston roof 

WallThck Sets the exterior wall thickness; controls the distance in the X, Y plane 
from the roof definition boundary to the intersection of the plate and 
the bottom plane of the roof 

Fascia Sets the width of the fascia on roofs with plumb fascia and horizontal 
soffits; does not affect the roof thickness (controlled by RoofThck); 
fascia width cannot exceed the plumb distance through the roof 
thickness; only available when SoffHorz and FaciaPlb are toggled on 
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SoffHorz/SoffIncl Toggles between SoffHorz and SoffIncl to define the shape of the soffit; 
toggle SoffHorz on to draw the underside of the overhang (the soffit) 
horizontal, or parallel to the ground; toggle SoffIncl on to draw the 
soffit inclined, or parallel to the roof plane 

FaciaPlb/FaciaSqr Toggles between FaciaPlb and FaciaSqr to define the shape of the 
fascia; toggle FaciaPlb on to draw the outside of the overhang (the 
fascia) plumb, or perpendicular to the ground; toggle FaciaSqr on to 
draw the fascia is square, or perpendicular to the roof plane 

EndWall Toggles the construction of end walls as part of the roof model (end 
walls fill in the gaps between the plate and the underside of the roof); 
when you toggle EndWall on, RoofIt prompts you to enter the color of 
the end walls; see “Color Menus” in “The Drawing Board” chapter for 
more information about how to choose a color 

EndWall only appears when you select a Gable, Boston, Gambrel, or Shed roof type. RoofIt 
determines the thickness of the end wall by using WallThck. 

 

Roof parameters 

 

2ndPitch and MidRidge settings 
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Gable offset 

 

Types of soffit and fascia 
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